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FCC Compliance Statement
This equipment has been tested and found to comply with the limits for a Class B digital
device, pursuant to part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference in a residential installation. This
equipment generates, uses and can radiate radio frequency energy and, if not installed
and used in accordance with the instructions, may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a
particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the
user is encouraged to try to correct the interference by one or more of the following
measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit different from that to which the 
receiver is connected.

• Consult the dealer or an experienced radio/TV technician for help.

Use of Trademarks, Registered Trademarks, and other
Protected Names and Symbols
This manual may make reference to trademarks, registered trademarks, and other
protected names and/or symbols of third-party companies not related in any way to
StarTech.com  Where they occur these references are for illustrative purposes only and
do not represent an endorsement of a product or service by StarTech.com, or an
endorsement of the product(s) to which this manual applies by the third-party company in
question.  Regardless of any direct acknowledgement elsewhere in the body of this
document, StarTech.com hereby acknowledges that all trademarks, registered
trademarks, service marks, and other protected names and/or symbols contained in this
manual and related documents are the property of their respective holders.
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Introduction
Thank you for purchasing a StarTech.com remote power control switch.  This product is
the perfect complement to our IP-based Server Remote Control product line or can be
used as a standalone power management solution.  Using a serial interface, you can
remotely manage the power status of up to eight devices.  For additional flexibility, you
can use industry-standard Ethernet patch cables to cascade up to 16 remote power
control switches together so that you can control up to 128 devices over a single
connection. 

Features

• Ideal accessory to StarTech.com’s Server Remote Control product line, or as a 
standalone power management solution

• Manage the power requirements of up to 8 computers or other devices from a single 
switch

• Versatile cascade feature allows you to combine up to 16 power management 
switches to control up to 128 devices

• Access the features of the management switch from its easy-to-use software 
interface or from the front panel

• Easy setup using industry standard cabling and rack-mountable form factor

Before You Begin

System Requirements

• A StarTech.com Server Remote Control console (i.e. SV1110IPEXT) with an available 
DTE serial connection, OR a host computer running Windows 95 or later with an 
available RS-232 serial port (“standalone” operation)

• For standalone operation only: The host computer must have an optical drive (CD-
ROM, DVD-ROM) for software installation

Contents

This package should contain:

• 1 x Remote Power Control Switch 

• 1 x Power Cord

• 1 x RS-232 straight-through serial cable

• 1 x Software Installation CD

• 1 x Instruction Manual

Instruction Manual

1



Site Preparation Considerations
PLEASE READ: IMPORTANT

To avoid overloading the power management switch and exceeding the electrical
tolerances of your site, it is important that you know the power consumption
requirements of the devices you will be connecting before attempting an installation of
this product.  Most items have their power consumption characteristics printed on the
outside of the device, on the power adapter (if applicable), or in their documentation.  If
you are unsure about the power needs of any device you wish to connect to the switch,
contact the manufacturer or your System Administrator.

If you are installing the switch into an existing site and are not altering other
components of your setup (i.e. adding an additional computer), it is likely you will simply
have to concern yourself with the devices you are connecting and not with the electrical
installation of the site itself.  If you have experienced power-related problems at the site
previously (i.e. breakers being tripped), you should consult a qualified electrician to
resolve those problems before beginning installation.

If you are installing the switch in a new site and have not been running the devices
you are connecting to the switch together before, you should inventory the requirements
of the devices you are installing and consult a qualified electrician to ensure the electrical
infrastructure will support the combined load of all the devices together without potential
problems.

Note the following considerations when connecting devices to the power management
switch:

1) The load of any single port cannot exceed 6 amps
2) The total load of all connected devices cannot exceed 15 amps

NOTE: Do not connect devices such as UPSes (uninterruptible power supplies),
extension cords, power bars, etc. to any port on the switch.  If you wish to use a UPS
solution, plug the power management switch into a UPS of sufficient capacity to handle
the simultaneous load of every device on the switch.  While it does not void the warranty,
the use of a UPS with the power management switch is not supported by StarTech.com.

Installing the Switch and Connecting Devices

1.  Place the power management switch near the devices you wish to use, mounting it in   
your rack or cabinet, if desired.  Connect the female end of the power cord to the   
connector on the left hand side of the rear panel, marked POWER IN.  Connect the 
opposite end to an appropriate power outlet.  Ensure the cooling vents on both
sides of the product are unobstructed.
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2.  Safely power down the devices you wish to connect to the switch.

3.  Connect the power plug for each device to OUTLET 1 through OUTLET 8 on the rear 
panel of the switch.

4.  You can power on each device by pressing the corresponding white button on the 
front panel of the switch.  When powered, the green on status LED will light    
underneath each button on the front panel.

Cascading Multiple Switches
One of the unique features of this product is the ability to combine up to 16 switches to
expand the total number of devices you can manage through the front panels and
software to 128 in total.  Cascading requires the use of a standard Ethernet UTP
(unshielded twisted pair) patch cable properly terminated with RJ-45 connectors on each
end.

1.  Place or mount the switches in the same manner as you did in the previous section.  
Ensure the cooling vents on both sides of the product are unobstructed.

2.  With the existing unit powered on, connect one end of the Ethernet patch cable to the 
STACKING OUT RJ-45 port on the rear panel of the new switch you are installing.

3.  Connect the opposite end of the Ethernet patch cable to the RJ-45 STACKING IN
port on the rear panel of the existing unit.

4.  Connect the female end of the power cord to the connector on the left hand side of 
the rear panel on the new switch.  Connect the opposite end to an appropriate 
power outlet.

5.  Safely power down the devices you wish to connect to the switch.

6.  Connect the power plug for each device to OUTLET 1 through OUTLET  8 on the 
rear panel of the switch.

7.  You can power on each device by pressing the corresponding white button on the 
front panel of the switch.  When powered, the green on status LED will light    
underneath each button on the front panel.

NOTE: Cascaded switches will assume the bank number (as indicated by the green
digital display on the front panel) in the order they are powered on.  For management
purposes, connect and power up cascaded switches in the order that will reflect which
bank number you want assigned to each switch.  See the next section for more
information about the bank number indicator.

Using the Front Panel
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The front panel is an easy way to determine the power status of the devices connected
to the switch and and the overall power load being experienced by the switch at any
time.  The following is an explanation of the buttons and indicators on the front panel:

CURRENT: The measurement of the current power load of the switch 
measured in amps.  If the number on the display is blinking, the switch is 
overloaded and one or more devices should be powered off to bring the load for
that switch below 15 amps.

1~8: Pressing this button supplies power to the corresponding port on the 
rear panel of the switch.  When the port is powered, holding this button for 
approximately 5 seconds and then releasing will power off the port.  This is not
an automated shutdown feature.  Use normal procedures for shutting 
down the operating system before turning off any port to avoid losing 
data.

ALARM: This light should not be lit under normal operating conditions.  If the 
light is on, the corresponding port is experiencing a hardware fault.  For more 
information, see the “Troubleshooting” section of the manual.

ON: When lit, the corresponding port is powered.

BANK: Indicates what unique number is assigned to the switch being 
managed, if two or more units are cascaded.  An un-cascaded unit is always 
assigned bank 01.  Other units will automatically assume the next available 
bank number in the order they are powered on.  This is important when using 
advanced features in the management software.

Management Option I: Server Remote Control
If you are using a StarTech.com Server Remote Control product to manage your
server(s), you can use its built-in support for this power switch to create a complete
remote management solution.

The instructions presented here may vary from what you see on your screen,
depending on which StarTech.com Server Remote Control product you are using
and what firmware version is installed.  For further assistance in locating and
activating this option in your version of the firmware, consult the documentation
that came with the Server Remote Control.  For the most current version of the
manual and additional product information, please visit www.startech.com.

1.   Connect the male end of a RS-232 straight through serial cable (provided) to the port 
marked RS-232 on the rear panel of the power switch.

2.   Connect the opposite end to the DTE serial port on your Server Remote Control 
unit.  The location and label of this port varies by product; is marked as DTE
Serial on the front panel of the SV1110IPEXT.

3.   Access the Web interface on your Server Remote Control by using a standard Web   
browser and entering the IP address of the unit.  Consult your documentation or your  
System Administrator for assistance in locating the IP address of your unit and 
accessing the Web interface, if necessary.
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4.    Login to the Server Remote Control as admin.  Choose the Admin/Setup option 
from the navigation bar at the top of the screen.

5.    From the Admin/Setup menu, choose Setup compatibility with host system, 
external KVM, external power bar.

6.    Go to the External Power Bar menu.  The default setting is None/Feature 
disabled.  Select Remote Power Control Switch from the menu.  The unit will 
activate the feature and return you to the menu after a short refresh period.

7.    Choose the Home option from the navigation toolbar at the top of the screen.  You 
will see the following controls underneath the thumbnail image of the remote system 
desktop:

Turn OFF/ON: Turns power for an outlet ON or OFF depending on its state 
when the button is pressed.  This action is the same as holding and pressing 
the white button for that outlet on the front panel of the power switch.  You must 
choose OK or Cancel in a dialog box before the switch carries out the action.

Cycle: Turns an outlet OFF for a short interval and re-powers it 
automatically.  Available only when the outlet’s state is ON.

Total Current: The total current load on the switch being monitored.
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Management Option II: Management Software
The management software allows you to power devices attached to your switch(es) on
and off and program advanced timer features to automate power events.  Please see
Appendix A, “Configuring Your Computers for Remote Restarts” for important additional
information.

NOTE: It is recommended that you disable or uninstall any existing monitoring software
installed on the host computer that uses the serial port, such as UPS automation
software, as it may interfere with the communication between the switch and the
computer. 

1.  Choose a computer to be the host for the management software.  Note that this 
should be a computer that will not be plugged into the switch if you will be using the 
provided software to remotely manage devices, and it should be in 
close proximity to the switch unit.

2.   Connect the male end of a RS-232 straight through serial cable (provided) to the port 
marked RS-232 on the rear panel of the power switch.

3.   Connect the opposite end to the serial port on your computer.  The labelling and 
location varies from model to model; consult your documentation or System 
Administrator for assistance.  Insert the CD that came with the switch into the host 
computer’s CD-ROM drive.

4.  Create a folder on a local drive of the host computer. This is the folder that will hold 
the files for the software on the host computer.  Use a folder location and name of 
your choosing.

5.  Open My Computer and double click the icon that represents the CD-ROM drive.  
Highlight the files PowerSW1.exe and define.ini and choose Copy from the Edit
menu.

6.  Open the folder you created in step 4 using My Computer or Windows Explorer.  
Choose Paste from the Edit menu.  You may wish to place a shortcut to 
PowerSW1.exe in an easily accessible place such as the Windows desktop.

When you launch the software, you will be presented with the following menu:
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The main menu of the management software is a graphical representation of the front
panel of the bank 01 switch unit and any switches cascaded to it.  The information
displayed corresponds to the physical front panel of the switch(es).  See the previous
section for more information.

The software uses a “short form” to identify ports and banks on prompts and dialog
boxes.  0105 refers to bank 1, port 5; 1202 refers to bank 12, port 2 (and so on).

Powering units on and off

You can power ports on a given switch by clicking the corresponding virtual PC x button
on the main menu’s graphical representation.  When clicked, the software will display the
following prompts:

Menu functions

File>Exit: Choosing the Exit option from the File menu closes the management
software.  Alternatively, you can also use the keyboard shortcut: Ctrl-X.

Setting>Connect: Choosing Connect from the Setting menu will cause the 
host computer to connect with the switches attached via the serial port.

Setting>Disconnect: Choosing Disconnect from the Setting menu will cause 
the host computer to stop monitoring the switch(es).

Setting>Configuration: This menu allows you to adjust the behavior of the 
switch management software and access advanced time management 
features.
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The General Tab
Select Com Port: This option changes the serial port that the host 
computer will use to connect to the switches.  You can select Auto
(recommended) or choose a serial port number from 1 to 8.

Auto-connect ioPower on Start: When checked, forces the 
management software to connect to the switch(es) automatically.  If 
disabled you must choose Connect from the Setting menu to begin a 
session.  The setting is unchecked by default.

Touch-Panel Power ON/OFF Confirmation Prompt: Sets whether 
the software will warn you before powering a port on or off from the 
main menu.  This setting in checked by default (recommended).

Choose OK to apply your changes to Cancel to discard them.

The Time Tab
This menu allows you to schedule power events using the drop boxes 
on the menu.

Enable: When checked, will cause the event to occur.  If unchecked, the 
event will not occur even when values are entered.
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Bank and Port: Specifies which switch (the bank) and what port on 
that bank that the power event applies to.  A setting of 0 means “all” in 
the software.  For example, bank 0, port 0 will apply the action to all 
ports on all banks.  Bank 2, port 0 will apply the event to all ports on 
bank 2.  You cannot use a port setting other than 0 when the bank 
setting is 0 (i.e. bank 0, port 2, meaning port 2 on every switch).  If 
that situation occurs, the software will ignore the event.

Power-On/Power-Off: Describes what action the software should 
execute on the switch at the given time.  Since this feature is 
designed for unattended operation, you will not be warned when the 
port(s) power off.

After/When: Allows you to specify a specific time in 24-hour format to 
power the port(s) on or off (up to 23 hours, 59 minutes) if When is 
selected, or after a specific duration if After is selected (up to 99 hours, 
59 minutes).

Hour/Minutes: Sets the time or duration of a power event in 
conjunction with the After/When setting.

Shutdown: When enabled, it will power off the host computer after 
the power event has been executed.  NOTE: If this option is selected, 
you will be unable to access the management software until the host 
computer is powered on locally.

Choose OK to apply your changes to Cancel to discard them.

NOTE: The power management software must be running and connected to the
switch(es) in order to perform unattended power events.  If the software is closed or
disconnected using the Connect>Disconnect menu feature, scheduled events will not
occur.

Right-click Menu feature

If you right-click anywhere on the main menu (excluding the PC x power buttons or
status indicators), the following menu will appear:

This option offers a quick way to power all the ports on a specific bank (or all ports on
every bank) on or off.  Once you highlight and choose your selection from the menu, you
will see a confirmation prompt similar to the following:

Choose OK to confirm your selection or Cancel to return to the software.
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Management Option III: Terminal Session
Since the power switch uses a serial interface, you can also manage it using a terminal
session through your preferred communications software (HyperTerminal, xterm).
Configure your software to the following settings:

Connection speed: 9600 bps
Data bits: 8
Parity: None
Stop bits: 1
Flow control: None

After the session has been established, you have to hit the [Enter] key twice
to go into command mode, then you can input commands within the terminal program
using the syntax detailed below.  This method is particularly useful if you need to
manage the switch from a non-Windows computer.  

NOTES:

• The commands are NOT case-sensitive.  The commands do not require a strict double-
digit entry of bank number or port number (such as ON 01 03 – Power on bank 1 port 3)
but can accept their single-digit entries (such as ON 1 3), and also allow multiple blank
spaces in between its command parameters (such as ON 1 3).

• When using HyperTerminal (and other terminal programs), note that [Scroll Lock]
should be OFF. Otherwise, you may not be able to enter commands. [Scroll Lock] is OFF
by default. However, if you cannot type in commands, please check the ScrollLock
status, which can be viewed on status bar at the bottom of your HyperTerminal window. If
ScrollLock is ON, hit [Scroll Lock] key again to reset it.

Notes:
1. A port number of 0 represents all ports; while a bank number of 0 represents all
cascaded banks.
2. If the bank number in any command is 0, then the corresponding port number must
also be 0 (therefore syntax like command 0 4 or “port 4 on all cascaded banks” is not
valid.  

Commands:

HELP or ? – Show Help Menu
Show the Help Menu on the HyperTerminal screen
Examples: 
HELP
?

QUIT - Exit serial command mode
Examples:
QUIT
Notes: 
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Once you exit serial command mode, you have to hit [Enter] twice again to restart
the serial command mode.

ON – Power ON
Power on one/all AC outlet port(s) immediately
Examples:
ON 1 4 – Power on port 4 on bank 1 immediately
ON 1 0 – Power on all ports on bank 1 immediately
ON 0 0 – Power on all ports on all cascaded banks immediately

OF – Power OFF
Examples:
OF 1 4 – Power off bank 1 port 4 immediately
OF 1 0 – Power off bank 1 all ports immediately
OF 0 0 – Power off all ports on all cascaded banks immediately

TA – Timer Activate at specific time point
Examples:
TA 1 4 ON 01:22:50 – Set timer to power on port 4 on bank 1 exactly at 01:22:50.
TA 1 0 ON 00:10:00 – Set timer to power on all ports on bank 1 exactly at 00:10:00
TA 0 0 OF 01:00:00 – Set timer to power off all ports on all cascaded banks at 01:00:00
(The system time should be calibrated before using this command for the first time.)

TF – Timer Activate after specific time duration
Examples:
TF 1 4 ON 03:25:56 – Set timer to power on port 4 on bank 1 exactly after 3 hour 25
minutes and 56 seconds.
TF 1 0 ON 00:10:00 – Set timer to power on all ports on bank 1 exactly after 10 minutes
TF 0 0 OF 01:00:00 – Set timer to power off all ports on all cascaded banks after 1 hour.

ED – Timer Activate every day at a specific time
Examples:
ED 1 4 ON 02:12:20 – Set timer to power on port 4 on bank 1 exactly every day at
02:12:20.
ED 1 0 ON 00:10:00 – Set timer to power on all ports on bank 1 exactly every day at
00:10:00.
ED 0 0 OF 01:00:00 – Set timer to power off all ports on all cascaded banks every day at
01:00:00.
Notes:
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The clock uses 24-hour format: 5:00 pm is the same as 17:00

EW – Timer Activate every week at a specific time point
Examples:
EW 1 4 ON 1 01:22:50 – Set timer to power on port 4 on bank 1 every Monday at
01:22:50.
EW 1 0 ON 3 00:10:00 – Set timer to power on all ports on bank 1 every Wednesday at
00:10:00.
EW 0 0 OF 5 01:00:00 – Set timer to power off all ports on all cascaded banks every
Friday at 01:00:00.
Notes:
A day of 0 represents Sunday; 1 represents Monday, and so on through Saturday (6)
for this reason.

TQ – Timer Quit
Examples:
TQ 1 4 ON – Cancel timer power-on setting on port 4 of bank 1
TQ 1 4 ON – Cancel timer power-on setting on port 4 of bank 1
TQ 0 4 - Cancel timer power-on&off setting on port 4 of bank 1
TQ 1 0 OF - Cancel timer power-off setting on all port of bank 1
TQ 0 0 ON - Cancel timer power-on setting on all port of all banks
TQ 0 0 - Cancel timer power-on&off setting on all port of all banks
Notes:
If you have not specified either ON or OF as the command parameter, it is
assumed that this Timer Quit directive will be directed on both the Power-ON and Power-
OFF settings that may exist for that specific port.

ST – Status
Examples:
ST 1 – Show the system status of bank 1
ST 16 – Show the system status of bank 16
ST 0 – Show the system status of all banks

UPGRADE – Upgrade Firmware
Example:
UPGRADE

SETTIME – Set Up System Date and Time
Example:
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SETTIME 2004/09/27 18:10:00 – Set up the system Date and time to be 2004/09/27,
18:10:00

GETTIME – Get System Time
Example:
GETTIME

VER – Firmware Version
Examples:
VER 01 – Show the firmware version of bank 1
VER 16 – Show the firmware version of bank 16
VER 00 – Show the firmware version of all banks
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Troubleshooting
Problem: One or more red ALARM LEDs is lit on the front panel of a switch.
Cause: The port(s) displaying the error have experienced a hardware problem.
Correction: Power the problem port(s) and or the switch on and off 2-3 times.  If this 
does not correct the problem, contact Technical Support.

Problem: The CURRENT indicator on the front panel is flashing.
Cause: The unit is experiencing a small overload.  
Correction: Power off and/or remove unnecessary devices from the switch to reduce the
overall load to 15 amps or less.

Problem: The switch does not have any power, but the wall power outlet is functional 
and the power cord is snugly connected to the rear panel.
Cause: Excess loads may have caused the internal breaker in the switch to trip open.     
Correction: Press the RESET button on the rear panel to reset the unit.  Remove
devices to avoid an overload and test the switch again.

Problem: The Server Remote Control/management software cannot connect to the
switch.
Cause: There is a configuration error, or a loose connection.
Correction: 1) Ensure that you are using the correct serial cable, and that the
connections between the serial switch and the Server Remote Control/computer are
snug.  2) Ensure the Com Port setting on the General tab on the
Setting>Configuration menu is correct and manually select the correct port number
from the list, if necessary (management software only).
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Input Voltage 100~240 VAC @ 50~60 Hz

Output Voltage 100~240 VAC @ 50~60 Hz
(Depends on power input)

AC Output Outlets 8

Front Panel Controls 8 x Power On/Off
Current Load Indicator (amps)
Bank Number Indicator
8 x Power LED
8 x Alarm State LED

Host Computer Interface RS-232 Serial

User Interface Front Panel
Power Switch Management Software

Max. Combined Switches 16 units via UTP Cable Cascade

Cascade Interface 1 x RJ-45 (input)
1 x RJ-45 (output)

Max. Current Load/Port 6 amps

Max. Current Load (Total) 15 amps

Operating Environment 32~113ºF (0~45ºC) @ 10-90% Rel. Humidity

Storage Environment -4~158ºF (-20~70ºC) @ 10-90% Rel. Humidity

Dimensions (LxWxH) 16.14 x 6.5 x 1.75” (410 x 165 x 44.5 mm)



Technical Support
StarTech.com’s lifetime technical support is an integral part of our commitment to provide
industry-leading solutions.  If you ever need help with your product, visit
www.startech.com/support and access our comprehensive selection of online tools,
documentation, and downloads.

Warranty Information
This product is backed by a one-year warranty. In addition, StarTech.com warrants its
products against defects in materials and workmanship for the periods noted, following
the initial date of purchase. During this period, the products may be returned for repair, or
replacement with equivalent products at our discretion. The warranty covers parts and
labor costs only. StarTech.com does not warrant its products from defects or damages
arising from misuse, abuse, alteration, or normal wear and tear.

Limitation of Liability

In no event shall the liability of StarTech.com Ltd. and StarTech.com USA LLP (or their
officers, directors, employees or agents) for any damages (whether direct or indirect,
special, punitive, incidental, consequential, or otherwise), loss of profits, loss of business,
or any pecuniary loss, arising out of or related to the use of the product exceed the
actual price paid for the product.

Some states do not allow the exclusion or limitation of incidental or consequential
damages. If such laws apply, the limitations or exclusions contained in this statement
may not apply to you.
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Appendix A: Configuring Your Computers for Remote
Restarts
Since most current computers use “intelligent” power supplies that have advanced power
management capabilities, once they are powered off from the switch their BIOSes must
be configured to return to a powered state when power is restored.

Most computers have a hardware configuration utility (usually called “setup”) that you
can access during the startup process by pressing a key or combination of keys on the
keyboard.  Since the act of powering off a port on the console is similar to a power failure
to the power electronics inside the computer, a setting must be changed that allows the
computer to start when a port is turned back on.

Look for a feature in your computer’s configuration utility that may be similar to State
After Power Failure.  Ensure that it is set to on so the switch can start the computer
without manual intervention.  As configuration utilities vary significantly from
manufacturer to manufacturer and model to model, consult your computer’s
documentation for information on how to access this setting on your computer.
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